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Change	colour	of	picture	in	photoshop

With	Jericho	McCune	I	RGB	Picture	from	Sergey	Tokarev	from	Fotolia.com	RGB	(red-green-blue)	is	a	commonly	used	colors	scale	For	graphics	-Modifies	software	to	create	images.	The	RGB	color	scale	is	the	default	color	scale	used	because	computer	monitor	use	it	to	emit	light.	Unfortunately,	many	printing	devices,	such	as	offset	lithograph,	use	a
CMYK	(cyan-brown-yellow-black)	ladder	for	printing.	Before	an	image	can	be	printed,	it	must	be	converted	into	the	correct	color	scale.	Due	to	the	high	cost	of	Adobe	Photoshop,	alternative	conversion	methods	can	be	used.	Download	GIMP,	a	free,	open-source	graphics	modification	of	the	program.	(See	Resources.)	Install	Gimp	by	double-clicking	the
downloaded	file	and	follow	the	steps	indicated	by	the	system	manager.	Download	the	CMYK	separation	plugin	for	GIMP.	(See	Resources.)	Install	the	plugin	by	double-clicking	on	the	downloaded	file.	Download	Adobe	Profiles	ICC.	(See	Resources).	Install	them	by	double-clicking	the	downloaded	file.	Run	Gimp.	Open	the	image	to	be	converted	by
clicking	"File",	then	"Open"	and	then	find	the	image	in	the	directory.	Right-click	on	the	image	and	select	"Image".	Then	select	"Separate	(Normal)"	and	accept	the	default	destination	profiles.	Right	mouse	button	on	the	image	and	select	"Image",	followed	by	"Separate",	then	"Save".	By	Roger	Smith	I	Line	4	Image	of	Chrisharyvey	from	Fotolia.com
Adobe	Photoshop	is	a	tool	created	to	improve	and	edit	images	using	various	techniques.	Using	Adobe	Photoshop,	it's	very	easy	to	digitally	change	images	and	post-processing	to	create	the	desired	look	when	you	take,	or	seeing,	the	image.	The	program	was	released	for	the	first	time	in	1990	by	Adobe	Systems	and	is	the	market	leader	for	image
manipulation,	since	2010.	There	are	many	techniques	within	Photoshop	to	realize	what	you	want	and	change	the	color	of	the	Line	can	be	relatively	simple	if	done	correctly.	Find	the	image	you	want	to	change	and	right-click	on	it.	Choose:	"Open	with>	Adobe	Photoshop."	This	can	also	be	realized	before	opening	photoshop,	choosing:	"File>	Open"	and
browsing	the	image.	Make	sure	the	image	is	in	RGB	color	mode	using	the	command:	"Picture>	Mode>	RGB	color."	Create	a	new	level	on	the	level	you	want	to	modify	and	fill	this	level	with	the	desired	color	for	the	lines.	Find	the	Pulldown:	Leyers	Palette	Blending	and	select:	"Sleenten>	Screen>	Linear	Dodge."	The	image	should	take	the	previously
selected	color.	Once	you	have	reached	what	you	were	looking	for	using	a	layer	or	more	layers	if	they	were	needed	more	colors,	flatten	the	image	below:	"Layer>	Lush	image"	and	then	save.	By	Ryan	Menezes	I	Jupiterimages	/	Comstock	/	Getty	Images	Most	Photoshop	default	models	use	neutral	shades	of	gray	because	color	colors	are	usually	not
counting.	When	applying	a	model	to	the	enlarged	image,	the	colors	of	the	image	is	combined	with	the	design	of	the	model	to	create	the	illusion	of	the	texture.	However,	you	can	place	a	diagram	on	other	layers	or	on	an	empty	canvas,	showing	the	color	of	the	model	in	your	finished	product.	To	change	this	color,	you	can	apply	a	colored	filter	to	an
existing	scheme.	Create	a	new	blank	file	in	Photoshop.	Right-click	the	clone	stamp	icon	in	the	toolbox	and	click	on	"Pattern	Stamp	Tool"	to	switch	to	the	template	stamp	tool.	Click	a	reason	from	the	drop-down	box	in	the	Options	toolbar.	Click	and	drag	it	to	the	canvas	to	complete	it	completely	with	the	model.	Click	"Image",	"Adjustments"	and	"Photo
Filter"	for	The	Photo	Filter	dialog	box.	Click	"Color"	and	click	on	the	colored	square	next	to	it	to	open	the	Select	Color	Filter	Color	dialog	box.	Choose	your	color	from	the	color	collector.	Type	"100"	in	the	density	text	box	and	click	"OK"	to	apply	the	color	to	the	model.	Click	"Edit"	and	"Define	the"	model	to	start	the	pattern	name	dialog.	Type	a	name
for	the	model,	then	click	"OK"	to	save	the	model	with	the	modified	color.	With	Michelle	Carvo	I	Creatas	Images	/	Creatas	/	Getty	Images	Image	Image	And	the	downsizing	was	once	something	just	professional	photographers	with	expensive	software	could	do.	However,	with	programs	like	Adobe	Photoshop,	modification	and	resizing	images	is	easy	for	a
relatively	inexperienced	computer	user.	If	you	have	recently	taken	a	picture	just	to	find	out	that	it's	too	small	for	your	liking,	you	might	try	to	make	the	photo	bigger.	Making	bigger	images	in	Photoshop	is	actually	quite	simple.	Open	Photoshop	by	clicking	Ã	¢	â,¬	Å	"Start>	Programs>	Adobe>	Photoshop.ã,	â,¬	Open	the	image	you	want	to	do	bigger	by
clicking	Ã	¢	â,¬	Å"	File>	Open	in	Photoshop.	Click	Ã	¢	â,¬	Å	"Image>	Image	size.	Click	the	box	next	to	Ã	¢	â,¬Å	Cuntrain	proportions	"so	that	it	is	selected.	This	is	important	as	it	will	guarantee	what	the	image	has	become	larger	in	the	correct	proportion.	Enter	the	desired	Ã	¢	¬	å	"widthÃ	¢	â,¬	and	Ã	¢	â,¬	å"	heightÃ	¢	â,¬	for	your	photo.	Click	Ã	¢
â,¬	å	"okÃ	¢	â,¬	to	accept	the	new	dimensions.	Photoshop	therefore	regulates	the	size	Of	your	image	accordingly.	Click	Ã	¢	â,¬	å	"File>	Save	as"	and	then	Ã	¢	â,¬	Å	"SaveÃ	¢	â,¬	to	save	the	resized	photo.	Now	you	made	the	biggest	images	in	Photoshop.	Whether	you	are	working	on	a	website,	a	mobile	app	or	even	a	brochure	layout,	there	is	always	a
period	of	time	before	being	completely	blocked	your	color	palette.	Even	when	you	have,	you	may	not	know	where	each	of	the	colors	will	be	applied	or	if	there	will	be	more	light	or	darker	nuances	used	in	certain	instances.	The	subtle	differences	between	#CCC	and	#AAA	are	quite	significant	to	be	able	to	try	more	color	variations	in	that	range	before
finding	the	perfect	gray.	When	you	are	the	knee-deep	in	Photoshop	layers,	it	can	be	painfully	slow	to	manipulate	colors	on	more	objects,	especially	if	you	want	to	go	back	and	forth	on	some	different	options	while	you	are	experimenting.	If	you	have	a	handful	of	icons	and	text	on	separate	levels,	your	only	options	are	going	through	and	selecting	each
level	to	change	the	colors.	Using	the	level	of	overlapping	FX	colors	can	help	speed	up	things	in	some	scenarios,	but	largely	frustrating	that	Photoshop	does	not	support	global	color	samples	in	the	same	way	illustrator.	Meanwhile,	there	is	a	sharp	small	smart	object	what	can	produce	truly	fast	results	when	you	want	to	quickly	change	colors	to	a	full
Photoshop	document.	It	takes	some	effort	in	advance	to	set	the	samples,	but	once	everything	is	in	place,	the	exchange	of	colors	on	the	layers	becomes	almost	instantaneous..01	Get	started	downloading	the	sample	project	files.	Levels	include	items	from	a	simple	iOS7	iPhone	app	layout:	a	title	bar	and	a	standard	list	view	with	text	and	icons.	We	will
create	intelligent	samples	to	use	for	the	title	bar	background	and	for	icons	in	the	list.	The	Photoshop	file	has	been	opened,	use	the	shape	instrument	(U)	to	draw	a	rectangular	shape	on	the	canvas,	holding	down	the	SHIFT	key	to	maintain	the	same	proportions.	The	color	of	the	shape	will	be	determined	by	the	color	in	the	foreground	in	the	instrument
panel.	To	change	the	color,	change	the	color	in	the	foreground	before	drawing	the	shape	or	double-click	the	shape	layer	later	.03.	Layersonce	You	have	the	drawn	shape,	convert	the	level	into	an	intelligent	object	by	right-clicking	on	the	level	and	selecting	Convert	into	an	intelligent	object.	You	can	also	do	it	by	selecting	Level>	Smart	Objects>
Convert	to	Intelligent	Object.	Once	your	Smart	Object	object	has	been	created,	double-click	on	the	name	in	the	level	panel	and	rename	it.	Select	the	Move	(V)	tool	and	place	your	color	sample	on	the	background	shape	of	the	title	bar.	With	Smart	Swatch	selected	in	the	Layers	panel,	select	Transform>	Scale	or	press	CMD	+	T	to	view	the	free	distortion
options	on	the	intelligent	object.	Now	extend	the	color	sample	until	it	covers	the	entire	title.	Don't	worry	if	you	overlap.	Double-click	the	object	to	apply	the	changes.05.	Transmission	of	clipping	your	color	swatch	layer	just	above	the	bg	layer	in	the	group	of	title	levels.	With	your	color	sample	in	place,	it	creates	a	clipping	mask	of	On	the	layer	and
selecting	Create	clipping	mask	or	level>	Create	the	clipping	mask.	You	can	alternate	ALT	+	click	between	the	two	levels	to	create	a	clipping	mask	more	quickly.	Now	you	will	see	that	the	title	text	took	the	color	owner	of	the	Smart	Object	Color	Swatch.06.	Copy	your	smart	object	with	the	Smart	Object	level	has	selected,	creates	a	copy	of	your	Smart
Object	color	sample	with	the	ALT	key	and	dragging	a	copy	of	the	color	sample	level	to	the	top	of	the	level	panel.	Another	way	to	quickly	create	a	copy	copy	is	affecting	CMD	+	J	with	the	selected	level.	Now	you	will	have	two	instances	of	the	intelligent	object	in	your	document.07.	Stretch	the	SwatchPosition	the	newly	created	instance	of	your	sample
over	the	remote	icon	in	the	list	group.	Now	extend	(CMD	+	T)	color	sample	vertically	to	extend	all	icons	in	the	list.	It	could	stretch	the	color	sample	to	only	extend	slightly	over	the	edges	of	the	single	icon,	but	since	we	are	doing	all	the	same	color	icons,	stretching	the	sample	to	cover	everything	that	will	make	it	fastest	apply	the	sample	to	each
icon.08.	Make	a	clipping	mask	your	smart	swatch	is	in	place,	create	a	clipping	mask	for	the	color	sample	using	the	shape	of	the	underlying	remote	icon.	To	do	this	alt	+	click	in-between	layers	or	right-click	on	the	sample	layer	and	choose	Create	clipping	mask.09.	Create	a	copynew	with	the	first	finished	icon,	create	a	new	color	sample	copy	and	place
it	just	above	the	Play	icon	in	the	Layer	panel,	which	is	the	next	in	the	list	group.	Because	the	color	sample	is	already	tense	to	cover	all	the	icons,	you	can	create	a	clipping	mask	without	having	to	resize	the	color	sample.	If	you	don't	already	have	tried	it,	Alt	+	Click	to	between	the	SMART	sample	and	the	Play	icon	to	quickly	create	a	clipping	mask.	The
mouse	icon	will	change	when	the	cursor	is	in	place	and	the	Alt	key	is	held.	Once	the	change	is	displayed,	click	to	set	the	mask.10.	Make	some	duplicationerepeat	step	9	for	the	remaining	two	icons	in	the	list	group.	This	will	give	you	a	smart	color	champion	for	each	element	in	the	PSD.	Remember	that	this	method	will	operate	even	if	you	will	use
primary	and	secondary	colors	within	the	same	document,	you	will	only	need	to	create	two	different	smart	objects	and	copy	them	separately	as	required	for	your	project.11.	Open	Smart	ObjectSwith	All	color	samples	now	in	place,	double-click	any	Smart	Smart	Objects	object.	This	will	open	the	intelligent	object	in	a	separate	window	with	the	original
editable	sheet	in	the	Layers.12	panel.	View	all	documents	from	the	menu	bar,	select	Window>	Arrange>	Tiles	all	vertically.	This	will	allow	you	to	view	both	documents	simultaneously.	Keep	an	eye	on	the	level	panel	to	give	you	a	bearing	for	which	the	document	is	currently	active.13.	Choose	some	Coloursdouble-Click	on	the	shape	of	the	color	sample
in	the	Smart	Object	Likeer	panel	to	change	the	color.	Choose	any	new	color	and	press	OK.	Save	the	Smart	Object	document	(CMD	+	S).	Each	instance	of	your	intelligent	color	sample	will	be	updated	to	the	new	color	in	the	main	Photoshop	document.	Once	you	have	saved	the	smart	object	modified,	close	the	document	by	selecting	File>	Close	or	hit
CMD	+	W.14.	Job	Donethat	is,	you're	done!	This	technique	can	save	a	lot	of	time	when	you	want	to	experiment	with	different	color	options.	Try	using	more	smart	color	samples	to	keep	a	global	editable	color	palette	of	your	'most	used	colored	documents.	Finally,	I	created	a	PSD	of	the	final	product,	which	is	Download	a	PSD.	Words:	Matt	D.	Smithmatt
D.	Smith	is	an	expert	in	the	design	of	branding	and	interface.	This	article	is	originally	appeared	in	the	number	of	Net	257	magazine.	257.	257.	
how	to	change	the	background	colour	of	a	picture	in	photoshop.	how	to	change	the	colour	of	a	part	of	a	picture	in	photoshop.	how	to	change	the	color	of	the	picture	in	photoshop.	how	to	change	the	colours	of	an	image	in	photoshop
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